Using Dynamic Views

Module Overview

The term dynamic views refers to a method of composing drawings that is a new approach to managing projects. Dynamic views can help you to:

- automate sheet creation;
- keep MicroStation files up to date by creating responsive drawings;
- eliminate errors in design and documentation;
- manage changes across MicroStation files.

This module presents features and techniques that can help you incorporate dynamic views technology into your existing workflows.

Module Prerequisites

- Understanding of design and sheet models
- Understanding of saved views
- Understanding of references and attachment settings, and procedures for working with references
- Knowledge about clip volumes and display styles
- Understanding of Project Explorer

Module Objectives

After completing this module, you will be able to:

- Create and compose drawings using the Drawing Composition workflow
- Create and modify dynamic views in 2D
• Create and modify dynamic views in 3D

**Introductory Knowledge**

Before you begin this module, let's define what you already know.

**Questions**

1. What is a saved view?
2. What is a sheet model?
3. What is the purpose of Project Explorer?

**Answers**

1. A named view definition saved in a DGN file for later recall or for attaching to another model as a reference.
2. A type of model that serves as an electronic drawing sheet. It typically consists of design or drawing model references that are scaled and positioned to create a printable drawing.
3. It is used to manage project data within MicroStation. Project data is stored in link sets in a DGN file or in a DGN library. A link set contains hierarchical information about links or grouped information in project data.
Creating and Composing Drawings

When a team of users works on a project, they typically work on separate files to allow multiple people to work at the same time. Members of the team work on different aspects of the project, and references are used to communicate graphic content across the team.

The Drawing Composition workflow introduces a new way of creating and composing your drawings. It offers a dynamic approach for interconnecting project drawings worked on simultaneously by a project team.

The Drawing Composition workflow makes use of a new concept: Dynamic Views. Dynamic Views is a general name that encompasses several related technologies which share a common goal of making model analysis and documentation more interactive and intuitive. Using dynamic views you can create live, intelligent sections of a design composition that update automatically as the design evolves. Section views, detail views, and elevation views are types of dynamic views.

Design, drawing, and sheet models

In a DGN file you can create multiple models of different types: design models, drawing models, and sheet models.

When creating design geometry in 2D or in 3D, you work in a design model. A design model contains the elements that represent what is built, drawn at full scale (1:1). It is not intended for publication, only for active editing.

To create a more complex design, multiple design models can be referenced to each other, also at full scale (1:1), thus forming a design composition. Examples: a 3D model of a building, a roadway plan in 2D, an electrical layout for a shopping mall.

By default the view windows of a design model have black backgrounds.

A drawing model is always 2D and stores a subset of a 2D or 3D design model or design composition (elements and references). It can be used to compose a drawing with global annotation, allowing you to separate the annotations from the geometry.

Examples: a plan of a 3D building model with dimensions, a 2D roadway plan including annotation.

By default the view windows of a drawing model have grey backgrounds.

To define printed output you create a sheet model. A sheet model is ready for printing or publishing and includes a boundary, sheet information, and additional annotation. Design models and/or drawing models are attached as references.
Creating and Composing Drawings

and scaled to fit the sheet. Each reference in a sheet composition can have its own attachment scale, allowing you to create a sheet with multiple scales. Examples: a sheet layout with a plan and sections of a 3D building model, a sheet layout with segments and details of a 2D roadway plan. By default the view windows of a sheet model have white backgrounds.

Advantages of using a drawing model

Using drawing models is optional. The drawing model is an intermediate stage between the 2D or 3D design and the printable sheet model. It is the first place one would start thinking about annotation and output scale, to get the data ready for presentation.

A drawing model allows you to separate annotations from the design. Placing annotations, for example room labels, directly in the design model is not recommended, because they may clutter the design geometry and may not be presented correctly when reusing the design in other drawings. This applies to 2D designs, but it is even more obvious when working in a 3D design model. Think for example of annotations that get partially clipped out in some views, or text elements that appear as edge-on lines in an elevation view. Adding annotation to a 2D representation of the model, like a drawing model or a sheet model, is easier and gives better results.

Another option would be to place the annotation, for example the room labels, in the sheet model. Usually multiple sheet models are created from a design model, so this would mean that you have to place duplicates of each room label in every sheet. Using a drawing model can simplify this. It allows you to create any annotations or embellishments that need to be shared across multiple sheets.
Note: Of course you can also place sheet specific annotation in the sheet model.

In addition to creating centralized annotations, you can also setup design information that spans multiple sheets. By creating a drawing model and referencing parts of it to multiple sheet models, the display and symbology of those sheet models can be controlled by adjusting the drawing model. This is very efficient when the sheet models all have to show parts of the same model with identical symbology and level display settings, like for example when generating multiple sheets along a roadway.

A drawing model allows you to pre-specify its output scale by setting the annotation scale. When a drawing model is attached to a sheet, its annotation scale is used as the default for the attachment's detail scale.

Note: You will explore these features in the exercises in this module.

Technically speaking, a drawing model is the same as a 2D design model, but it has an additional flag to designate it as a drawing model. By giving it a separate model type, it is possible to list them separately in Project Explorer, provide a unique background color, and – in the future – develop tools specific to drawing models.
The Drawing Composition Workflow

The Drawing Composition workflow is available as a group of tasks in the Tasks dialog. The tasks are arranged from top to bottom, to take you through the process of creating and composing drawings in a logical way.

Organize – Using these tools you can explore and manage your project data in Project Explorer, which is a catalog of your project resources or a hyperlinked table of contents.

Drawing / Solids Modeling – These two tasks provide commonly used drawing tools to create geometry in 2D or 3D.

Design Composition – The tools in this task allow you to create a design model and attach references at full scale (1:1) to create a design composition. In
addition, you have the option to create a 2D drawing model, as an intermediate between the design and the printable sheet.

Create Views (2D) / Create Views (3D) – At this stage, you compose all the saved views in the project. The tools allow you to set the view attributes and level display, and to create clip volumes and saved views.

**Note:** To place callouts and create linked saved views you can use the Detailing Symbols tools in the Annotate task.
Sheet Composition – The tools in this task allow you to create sheet models, define sheet boundaries, and work with references.

Annotate – This task contains various tools to complete the sheet model and add dimensions, patterns, texts, and detailing symbols. These tools can be used at various moments in the Drawing Composition workflow:

- to add centralized annotations to a drawing model;
- to add sheet specific annotations to a sheet model;
- to place callouts with linked saved views in a drawing or sheet model.
Using Dynamic Views in 2D

Although the dynamic view concept is designed primarily for a 3D environment, it can also be applied to 2D workflows.

In this chapter, you will use the tools in the Drawing Composition workflow to:

- create a 2D design composition;
- create a drawing model and attach the 2D design model (without using a saved view);
- add drawing annotations and set the display properties;
- define and create dynamic views in the drawing model;
- create sheet models and attach the dynamic views;
- add sheet annotations;
- modify the 2D design model (geometry) or the drawing model (annotation, clip volumes, display properties).

Creating a 2D design composition

Using the tools in the Design Composition task you can create new design models and attach references as background. The Drawing task offers the tools to create and modify the geometry. A design model is always drawn at full scale (1:1).

To create a more complex design, multiple design models can be referenced to each other, thus forming a design composition.

In this exercise, you will create a roadway plan by copying an existing design model from the civil examples.

⇒ Exercise: Copy a DGN file with a design model

1. Set the following in the File Open dialog:
   
   Project: Civil

2. Open BSI400-W01-Design.dgn in the folder Designs and open the Horizontal Alignments model.

3. Save the file as Roadway-Design.dgn.

4. Open the Models dialog, select Edit Model Properties for the Horizontal Alignments model, and set the annotation scale to Full Size 1=1.

5. Open the Design Composition task and select References.

6. Detach the reference.
7 Open the Organize task and select Project Explorer.
8 Expand the Designs node.

![Project Explorer](image)

The three models in the copied DGN file are automatically added to the list, because the Designs node lists all design models in the Designs folder of the Civil project.

9 (Optional) To view its definition right-click the Designs node and select Properties.

![Properties](image)

10 Save the DGN file (if this is not being done automatically).

**Creating a drawing model**

Although using a drawing model in a 2D workflow is optional, it may help you to get the data ready for presentation.

A roadway plan for example may require several sheet models to cover the whole area. A drawing model allows you to layout the saved views that will be used to reference the model into the sheets. This way you can manipulate the coverage of the roadway plan all from the drawing model by adjusting the saved view frames. The sheets will update accordingly.

Using a drawing model also makes it easier to position the annotation that is common to all sheets. Since the view frames for the sheets are controlled from
the drawing model, the common annotations can be placed in the drawing model and positioned to fit the view frames.

In addition, a drawing model allows you to setup a specific level display and symbology that will be identical throughout the various sheet models. In that case, you have to attach the design model to the drawing model without using a saved view, otherwise you will not be able to change the display properties in the drawing model, only in the original source view. This method allows you to setup different presentations in different drawing models, while the design model is not affected.

To create a drawing model you can use the tools in the Design Composition task.

➔ **Exercise: Create a drawing model in a new DGN file**

1. Continuing in Roadway-Design.dgn, open the Design Composition task and select New.

2. Navigate to the Drawings folder (..\Examples\Civil\dgn\Drawings\) and create a new DGN file Roadway-HorizontalAlignment.dgn, using the civil seed file ..\Civil\seed\seed.dgn.

3. In the Design Composition task, select Create a new design model.

4. In the Create Model dialog, set the following and click OK:

   * **Type:** Drawing (set first temporarily to Design, afterwards change to Drawing, otherwise due to a bug in MicroStation V8i SS2 08.11.07.443 the level symbology overrides as stored in the saved view will not be applied to the nested references)

   * **Name:** Composition Roadway

   * **Annotation Scale:** 1”=50’

   The annotation scale will be used as default when attaching the drawing model to a sheet model later. And also to scale the annotations in the drawing model itself, of course.

   Note the grey background, indicating that this is a drawing model.

5. In the Design Composition task, select References.

6. Attach the Horizontal Alignments design model in Roadway-Design.dgn as a reference, using the following settings:

   * **Orientation:** Coincident - World

   * **Scale (Master:Ref):** 1:1

   You will add the common annotations that must appear on all sheets.
7 Set the following:

*Active Level*: Plan Text Notes

*Active Color*: 4

8 Open the Annotate task and select Place Text.

9 Select the text style 1/2 in, ensure the annotation scale lock is enabled, and place the three texts like in the image below.

To spare time you will copy the remaining annotations from an existing drawing model.

10 In the References dialog, turn off the display of the referenced Horizontal Alignments model.

11 Attach the model in ..\Drawings\BSI400-HorizontalAlignment.Drawing.dgn with the following settings:

*Orientation*: Coincident - World

*Scale (Master:Ref)*: 1:1

*Nested Attachments*: No Nesting

12 Select all annotations except for the three texts you placed yourself (89 elements) and copy them into the active model.

**Hint**: If you can not select the annotations, please check if the Locate setting is enabled for the referenced model.

13 Detach the model in BSI400-HorizontalAlignment.Drawing.dgn and turn on the display of the referenced Horizontal Alignments model.
The active drawing model now contains all annotations, separate from the geometry in the attached design model.

In the Organize task, select Project Explorer and expand the Drawings node.

The new drawing model is automatically added to the list of drawing models.

Creating dynamic views in 2D

To simplify the creation of sheet models, you predefine saved views in the drawing model (or in the design model or design composition). The Create Views (2D) task contains tools for doing so.

To define which part of the drawing will be displayed on the sheet, a clip volume is created. Together with the level display and view attributes settings, the clip volume boundary is saved in a saved view. The saved view can then be attached as a reference to a sheet model.
In 2D, a clip volume can be defined in several ways (by element, by 2 points, by polygon, fitted) using the Apply or Modify Clip Volume tool. It can be saved as a named fence, but this is not required.

There are two ways to create a saved view from a clip volume in 2D:

- manually, by using the Create Saved View tool;
- automatically, by enabling the Create Dynamic View check box in the tool settings of the Apply or Modify Clip Volume tool.

When manually creating a saved view, there are only two methods: From View or From 2-Points. The clip volume can be rotated, but the saved view boundary is always parallel to the view window.

The second option allows you to create a rotated saved view.
When automatically creating a saved view, the Create Dynamic View dialog opens. It allows you to create a saved view and, if you like, also a drawing model and a sheet model.

To display the saved view boundary in the drawing model place a checkmark in the Show column in the Saved Views dialog. This also allows you to select the boundary with the Element Selection tool (or a fence) and manipulate it like a standard element.

⇒ **Exercise: Create a dynamic view from a clip volume**

1. Continuing in Roadway-HorizontalAlignment.dgn, set the active level to Clip Boundry and the active color to 6.
2 Draw three rotated blocks like in the image below.

You will create a clip volume from one of the blocks and capture it in a saved view.

3 Open the Create Views (2D) task and select Apply or Modify Clip Volume.

4 In the tool settings, select Apply Clip Volume By Element, enable Create Dynamic View, and select a block.
5 In the Create Dynamic View dialog, only enable Create Saved View, set the name to Segment A and the View Type to Saved View, and click OK.

![Create Dynamic View dialog](image)

Only the clipped part of the drawing model is displayed now.

6 Select View Previous to display the complete drawing model again.

The block that was used as clip element has disappeared. Instead you can display the saved view boundary.

7 Open the Saved Views dialog to see that the Segment A saved view is created.

8 Click in the Show column to display the saved view’s boundary.

![Saved Views dialog](image)
Creating sheet models and attaching dynamic views

The next step is to create a sheet model and attach the saved view as a reference. The Sheet Composition task supplies the tools for this.

Note: This step can also be automated, as explained in the next section.

Usually, the sheet border is placed at full size, so that the sheet model does not have to be scaled when it is printed. The saved views are referenced at the appropriate scales as required. By default, the annotation scale as set in the referenced model is used.

Synchronizing the saved view

When you attach a saved view, you can enable Synchronize with Saved View to synchronize the reference with the original saved view. This has the following effect.

- When the boundary of the original saved view is modified, the reference’s saved view boundary is automatically updated. The reference center and saved view center remain aligned, so the reference may be shifted.
- When changing the level display, view attributes, or other display properties in the source view, you first have to store these new settings in the saved view by clicking Update Saved View Settings in the Saved Views dialog. Otherwise the appearance of the referenced saved view will not change.

Remember that a saved view is a view definition, which only includes the display properties for both the active model and (nested) references. A saved view contains no geometry. So the model that is displayed in the saved view is always automatically updated.

Adding a drawing title

To create a drawing title describing the drawing on the sheet, enable the Create check box in the Drawing Title section and type a name. The drawing title is
associated to the reference and contains placeholder fields that reflect for example the drawing title name and the detail scale.

**Hint:** Ensure that in the sheet model properties the option Update Fields Automatically is enabled, to have the fields automatically updated when the model or file properties from which the fields were derived are changed. (Fields derived from element properties are automatically updated to reflect property changes.)

> **Exercise: Manually create a sheet in a separate DGN file**

1. Continuing in Roadway-HorizontalAlignment.dgn, in the Composition drawing model, open the Sheet Composition task and select New.
2. Navigate to the Sheets folder (.\Examples\Civil\dgn\Sheets\) and create a new DGN file Roadway-PlanSegmentA.dgn, using the civil seed file.
3. In the Sheet Composition task, select Create a new sheet model.
4. In the Create Model dialog, set the following and click OK:
   - **Type:** Sheet From Seed
   - **Seed Model:** select ModelSeed.dgn in ..\Examples\Civil\seed\ and then the model SheetSeed
   - **Name:** Plan Segment A
   - **Annotation Scale:** Full Size 1=1
   - **Update Fields Automatically:** enabled
   - **Sheet Name:** S01
   - **Sheet Number:** 1
   - **Display Sheet Boundary:** enabled
   - **Size:** ANSI D
   - **Origin:** X=0, Y=0
   - **Can be placed as a cell:** disabled

Note the white background, indicating that this is a sheet model.

5. In the Design Composition task, select References.
6. To attach a border select Attach Reference and set the following:
   - **File:** BSI400-C00-Border.dgn in ..\Examples\Civil\bdr\Model:** Detail Border Design
Orientation: Coincident - World

Scale (Master:Ref): 1:1

You can use the same tool to attach the saved view Segment A, but it is easier to drag and drop it from Project Explorer.

7 In the Organize task, select Project Explorer and expand the Drawings node.

8 Expand the Composition Roadway model in Roadway-HorizontalAlignment.dgn and note that there is a folder Saved Views now.

9 In this folder, select the saved view Segment A and drag and drop it into the view.

The Reference Attachments Settings dialog opens, with many settings already set correctly.

![Reference Attachment Settings dialog](image)

Note that the detail scale is set by default to the annotation scale of the drawing model: 1"=50' (1 inch = 50 feet, which equals 1=600)

10 Set the following:

- **Detail Scale**: 1"=50'
- **Scale (Master:Ref)**: 1.000000:600.000000
Logical Name: Segment A
Synchronize with Saved View: enabled
Drawing Title / Create: enabled
Drawing Title / Name: Segment A

Note: When you place a saved view on a sheet using drag and drop, the Live Nesting depth is always set to its maximum value: 99.

11 Click OK and place the saved view on your sheet.

12 Save the DGN file.

➔ Exercise: Update the drawing title

1 Continuing in Roadway-PlanSegmentA.dgn, in the Plan Segment A model, zoom in to the drawing title.

The drawing title contains two placeholder fields.

2 Select Element Selection, right-click the text string Detail Scale in the drawing title, and in the context menu select Edit Text.

The Text Editor opens containing the selected text string.

3 Right-click the text string in the Text Editor and select Edit Field.
4. In the Fields Editor, select the property Detail Scale in the General section and click OK.

5. Accept with a data point.
   
The string 1”=50’ is displayed now, derived from the detail scale of the referenced Composition Roadway model.

6. Open the References dialog and double-click the Composition Roadway model.

7. In the Attachment Settings dialog, change the Detail Scale to 1”=100’ and click OK.
   
The referenced model is scaled and the detail scale in the drawing title is automatically updated.

8. Select Undo to reset the attachment scale to 1”=50’.

**Automatically creating a sheet model**

Instead of manually creating a sheet model, you can enable the Create Sheet check box in the Create Dynamic View dialog when creating a clip volume. Then a sheet model will be created automatically, in the active file or in a new file.

**Exercise: Automatically create a sheet model from a clip volume**

1. Return to the Composition Roadway model in Roadway-HorizontalAlignment.dgn.

2. Open the Create Views (2D) task and select Apply or Modify Clip Volume.
3 In the tool settings, select Apply Clip Volume By Element, enable Create Dynamic View, and select a block.

4 In the Create Dynamic View dialog, enable Create Saved View and Create Sheet, and set the following:

   Name: Segment B

   View Type: Saved View

   Seed Model: enabled and set to ModelSeed.dgn, SheetSeed in ..\Examples\Civil\seed\  

   File Name: enabled, click the Create New Sheet File button, navigate to the ..\Civil\dgn\Sheets\ folder, set the file name to Roadway-PlanSegmentB.dgn, and click Save

   Annotation Scale: Full Size 1=1

   Make Sheet Coincident: disabled

   Open Model: enabled

5 Click OK.

   The new sheet model opens with the saved view attached.

6 Attach the border using the following settings:

   File: BSI400-C00-Border.dgn in ..\Examples\Civil\bdr\  

   Model: Detail Border Design

   Orientation: Coincident - World
Using Dynamic Views in 2D

_scale (Master:Ref): 1:1

This is easier and the result is the same as in the previous exercise.

7. In the Organize task, select Project Explorer and expand the Sheets node.
   Both sheets are added to the list.

8. Save the DGN file.

Modifying dynamic views

This workflow allows you to adjust or fine-tune the content of the sheets by centrally making changes to the drawing model. You can for example modify the saved view boundaries or position annotations so that they fit in the saved view frames. Or you can define display properties (level display, view attributes, level symbology, etc.) that should be identical in multiple sheets.

- Modifications to the geometry or annotations in the design models or drawing model are automatically updated in the sheets. That’s obvious, as the models are referenced into the sheets.

- Changing a saved view boundary in the drawing model is immediately reflected in the associated sheet if Synchronize with Saved View is enabled for the referenced saved view.

- Changes to the display properties in the drawing model are only reflected in the sheets if you update the saved view settings and Synchronize with Saved View is enabled.

Note that you can not change the display properties of elements that are attached through a saved view, as these are controlled in the saved view. For
example, you can not turn off a level or the fill display. This can only be done in the original source view.

**Exercise: Control the presentation on the sheets by adjusting the drawing model**

1. Return to the drawing model in Roadway-HorizontalAlignment.dgn.

   **Hint:** If the clip volume is still active, select the Clear Active Clip Volume tool and click in the view.

2. Open the Saved Views dialog and click in the Show column of the Segment B saved view to display its boundary.

3. Select the saved view’s boundary with the Element Selection tool and use the edit handles to stretch the saved view boundary and its clip volume.

4. Click Next Model (or Previous Model) to view that the sheet model is automatically updated.

5. Click Previous Model to return to the Composition Roadway model.

6. Right-click one of the boundary lines on the Plan Prop Boundary RW level, click Level Off in the context menu, and accept with a data point.

7. Disable the Construction button in the View Attributes dialog to turn off the display of the saved views’ boundaries.

8. Click Next Model.
The appearance of the referenced model has not been updated.

9 Return to the previous model.

10 In the Saved Views dialog, select Segment B and click Update Saved View Settings.

11 Ensure that Update Camera Position is off and click in the view to update from.

**Hint:** When you pan, zoom, or rotate the view, these changes are also saved on the next saved view update. To avoid these settings being updated in the saved view, the Update Camera Position check box should be disabled.

12 Click Next Model to see that the appearance of the referenced model has been changed.

13 Return to the drawing composition model.

To change the symbology of the elements in all sheets, you can enable and set the level symbology overrides.

14 In the View Attributes dialog enable Level Overrides.

All elements are white and grey now.

Let’s override the colors in the nested design model and ensure that all other elements keep their original color.

15 Open the Level Manager dialog and set the symbology method to Overrides.

16 In the left pane, select the referenced model and change the colors of the used levels.

17 Select all used levels, right-click in the Style column and in the context menu select All Overrides Off.
18 Do the same for the Weight column.

19 In the left pane, select the active model and turn all overrides off for the color, the style and the weight.

20 Save the settings.

   The drawing model looks different now. You can always return to the original color display by disabling Level Overrides in the View Attributes dialog.

21 In the Saved Views dialog, select Segment A and click Update Saved View Settings.

22 Do the same for the other saved view(s).

23 Open the sheets to view that the symbology of the referenced elements has been changed.

24 Close the DGN file.
Using Dynamic Views in 3D

In a 3D environment, the Dynamic Views technologies allow you to clip a model and generate section graphics on the fly. The term *section graphics* refers to the lines, arcs, and curves displayed in a view after you create a clip volume that cuts through a solid, surface, or mesh. The displayed section graphics are defined by the intersection between the clip volume faces and the original elements.

Section graphics are dynamically generated at display time and are not stored as real elements. They can be captured in a saved view that is linked to the clip volume, a *dynamic view*. When creating a drawing model or laying out sheets, you can attach the saved view, which will then create a dynamic view link to the source model.

The basic workflow to create plans, sections, elevations, and details from a 3D model is as follows:

- create a 3D design composition
- create a dynamic plan view in the 3D design model (or another dynamic view) and attach it to a 2D drawing model
- add drawing annotations
- define and create dynamic section, elevation, and detail views in the drawing model, using the Detailing Symbols tools
- create sheet models and attach the dynamic section, elevation, and detail views
- add sheet annotations
- modify the 3D design model (geometry, display properties) or the 2D drawing model (annotation, clip volumes, callouts)

The tasks in the Drawing Composition workflow provide the tools to support each step in this process.

Creating a 3D design composition

MicroStation offers you all kinds of 3D tools to perform 3D design and modeling: surface modeling tools, solids modeling tools, mesh modeling tools, and feature modeling tools. Using the tools in the Design Composition task you can create new design models and attach references. A 3D design model or design composition is always drawn at full scale (1:1).
Exercise: Copy a design model of a 3D house

1. Create a new file House.dgn, using the seed file ModelMetricGeneral.dgn.
2. Open the Models dialog and import the model 3D Model from Drawing Composition.dgn.
3. Try to rotate and tilt the 3D model by pressing the Shift key, holding the mouse wheel down, and moving the mouse.
4. Open the Presentation section in the View Attributes dialog and set the display style of the view to Illustration.

Note: How to use display styles is explained in the module ‘Viewing xxxx’.
5. Turn off the level ceiling.

Creating a drawing model with a dynamic plan view

The first step in the process to create sections, elevations, and details of your 3D model is to create a dynamic plan view in the 3D design model and attach it to a drawing model.
You can do this by creating a horizontal clip volume with the Apply Fitted Section XY-Plane tool and Create Dynamic View enabled. In the Create Dynamic View
dialog, always enable Create Saved View, to link the saved view to the clip volume and make it dynamic.

![Diagram](image)

(1) The clipped plan saved view is placed as a reference in a drawing or sheet model.

If you like, you can also enable Create Drawing, to automatically create a new drawing model and attach the plan view. When you decide to create the drawing model yourself, then don’t forget to enable Synchronize with Saved View when attaching the plan view, to have it automatically synchronized with the source view.

The Create Views (3D) task contains the tools to create clip volumes and set the display properties.

In the next series of exercises, you will create a design model, a drawing model, and sheet models in a single DGN file. This is not a typical workflow, but it lets you see the effects easily. When storing the models in multiple files, you will have to use Project Explorer and create links to organize the models, references, and saved views.

**Note:** How to create a project link set and links is explained in the module ‘Using Project Explorer’.

**Exercise: Create a drawing model with a floor plan of a 3D house**

1. Continue in House.dgn, in the model 3D Model.

   To create a floor plan of the house you will create a clip volume with a horizontal section plane, capture it in a dynamic view, and attach this view to a new drawing model.
2 Select Apply or Modify Clip Volume in the Create Views (3D) task, select the Apply Fitted Section XY-Plane tool, enable Create Dynamic View, and click in the view.

3 In the Create Dynamic View dialog, set the following and click OK:

   Name: Plan

   Create Saved View: enabled

   Note: Always enable Create Dynamic View and Create Saved View, otherwise you will not create a dynamic view! When you create a saved view manually from an active clip volume with the Create Saved View tool, the section graphics will not update automatically.

   View Type: Plan View

   Create Drawing: enabled

   Annotation Scale: 1:50

   Create Sheet: disabled

   Open Model: disabled

The drawing model is full size (1:1). The annotation scale 1:50 will be used to scale the annotations in the drawing model and also as default attachment scale when attaching the drawing model to a sheet model later.
Note that the model in view 1 has been clipped horizontally.

4 Select Show or Hide Active Clip Volume in the Clip Volume toolbox and click in the view to display the clip volume.

5 Open the Models dialog to view that a drawing model Plan is created.

6 Open the Saved Views dialog to view the two saved views that are created: Plan and Plan [Drawing].

   The saved view Plan is referenced in the drawing model Plan. The saved view Plan [Drawing] can be referenced later in a sheet model.

7 Open view 2 and select Window > Tile to tile the views.

8 Open the View Attributes dialog in view 2 and in the View Setup section set the model to Plan.

9 Ensure view 2 is active and open the References dialog to view that the model 3D Model is attached to the drawing model Plan using the orientation (saved view) Plan.

Note: Another option is to create a drawing model manually and drag the saved view Plan into it to attach it as a reference. In that case ensure that Synchronize with Saved View is enabled.

Now you will modify the clip volume and move its section plane, and view the result in the Plan drawing model.
10 Click in view 1 to make it active, select the clip volume, zoom in, and move the section plane upwards or downwards.

View how the blue rectangles in view 2 change as the section plane cuts through the upper or the lower kitchen cabinets.

11 Move one of the side handles and reduce the clip volume.

The section graphics in view 2 update automatically.

12 Make the whole floor plan visible again by moving the side handles of the clip volume.

Using detailing symbols to create dynamic views

A drawing model is always 2D and stores a subset of a 2D or 3D design model, in this case the dynamically generated section graphics that show the floor plan. In the drawing model, you can add dimensions and other annotation before you attach it to a sheet model for publication.

A drawing model (or a sheet model) is also the right place to define dynamic section, elevation, and detail views. These dynamic views can be created with the Detailing Symbols tools: a set of tools to place different types of callouts, drawing titles, and revision clouds. Using these tools you can for example place a section callout in a drawing model and automatically generate a linked section view which can be placed in a sheet model. Any modifications to the detailing symbol in the drawing model are reflected in the saved view that is displayed on the sheet. In addition, detailing symbols and drawing titles contain placeholder fields that update automatically and make the models more interactive and intuitive. The Detailing Symbols tools can be found in the Detailing Symbols toolbox and in the Annotate task.
When creating a section, elevation, or detail callout in a drawing model, the callout geometry is placed in the drawing model, a clip volume is created, and a linked saved view is created as part of the design model (section and elevation) or as part of the drawing model (detail). When laying out sheets, the saved view can be attached to a sheet model which will create a dynamic view link to the source model. Any changes to the clip volume in the drawing model will update the sheet.

(1) The clipped plan saved view is placed as a reference in a drawing or sheet model.
(2) The section callout can be placed in the drawing or sheet model to create the section view in the 3D model.
(3) The section saved view is placed as a reference in a sheet model.

**Detailing symbol styles**

When the saved view is attached to a sheet model, a drawing title can be created that describes the referenced model. How the callouts and the drawing titles will look is determined by the detailing symbol style that you select. The Default style, delivered in ustation.dgnlib, uses certain cells as bubbles in the
callouts and the drawing titles, but these can be changed to create a completely different look.

For example, in many European countries, a section callout would look like this.

The cells contain placeholder fields that are evaluated when the link is established between the callout and the drawing title. Custom detailing symbol styles can be created by selecting Element > Detailing Symbol Styles. Typically, these styles are defined by an administrator and stored in a DGNLIB file.

**Note:** How to create custom detailing symbol styles is explained in the MicroStation V8i Administrator Update course guide.

**Exercise: Create a sheet model with a cross section**

1. Continue in House.dgn and enlarge view 2, the view that displays the drawing model Plan.

2. Open the Annotate task, select Place Section Callout, and set the following:
   - *Detailing Style:* Default
   - *Flip Arrows:* disabled
   - *Annotation Scale lock:* enabled
   - *Preserve Up:* enabled
   - *Create Dynamic View:* enabled

3. Following the status bar prompt, identify an element in the floor plan in view 2.
This is how you define the target model, in this case 3D Model, in which the saved view will be created.

4 Place the start point of the section line left of the floor plan and the end point at the right.

5 In the Create Dynamic View dialog, set the following and click OK:
   
   - **Create Saved View**: enabled
   
   - **Name**: Section A-A
   
   - **Create Drawing**: disabled
   
   - **Create Sheet**: enabled
   
   - **Seed Model**: enabled and set to general.dgnlib, SheetSeed (in ..\WorkSpace\Projects\Examples\General\dgnlib\)

   - **Annotation Scale**: Full Size 1=1

   - **Make Sheet Coincident**: disabled

   - **Open Model**: disabled

   A section callout is added to the drawing model.

6 Open the Models dialog to view that a sheet model Section A-A is created.

7 Rename this model to Sections.

8 In the Saved Views dialog, a saved view Section A-A is added, that is contained in the design model 3D Model.

9 Open view 3 and 4 and select *Window > Tile* to tile the views.

10 Open the View Attributes dialog for view 3 and in the View Setup section set the model to Sections.

   Probably the section callout in the drawing model looks downward.

11 Right-click the section callout in view 2, select *Flip Direction* in the context menu, and click in the view.
Section A-A in view 3 is updated.

12 In the drawing model in view 2, select the section callout.

Note that the Place Section Callout tool created a clip volume in the drawing model.

13 Move the clip plane by dragging the green arrow and view that Section A-A in view 3 is immediately updated.

The clip volume in view 2 is linked to the Section A-A saved view that is part of the design model 3D Model. This saved view is attached to the Sections model.

14 Click in view 3 to make it active and open the References dialog to view that the model 3D Model is attached using orientation/saved view Section A-A.

Attach a saved view to a sheet manually

In the previous exercise, the sheet model was created automatically, because you enabled Create Sheet Model in the Create Dynamic View dialog. In the next exercise, you will add a section to an existing sheet model. There are several methods to place a saved view on a sheet.

- From the Project Explorer dialog: open the link set that contains a link to the saved view, drag the saved view link to the sheet, and drop it at the desired location.

- From the Saved Views dialog: drag the saved view from the saved views list to the sheet and drop it at the desired location. If the saved view is not in the active file, then first open the drop-down menu in the upper left corner and select the link set that contains a link to the saved view, or select a link to a file or model that contains the saved view.

- From its corresponding callout: right-click the callout and select Place Dynamic View. In this case the dynamic view can only be placed in the same view as the callout.
With all these methods the Reference Attachment Settings dialog opens, where you can enable Synchronize with Saved View and create a drawing title.

**Exercise: Add another cross section to the sheet model**

1. Continue in House.dgn and disable the grid lock.
2. In view 2, create a vertical cross section Section B-B using the Place Section Callout tool, without creating a sheet model.
3. To attach the saved view Section B-B to the Sections sheet model drag it from the Saved Views dialog to view 3 and set the following in the Reference Attachments dialog:
   - **Scale (Master:Ref):** 1:50
   - **Synchronize with Saved View:** enabled
   - **Drawing Title / Create:** enabled
   - **Drawing Title / Name:** Section B-B
4. Click OK and place the saved view on the sheet.
   A drawing title is created under the reference. The fields of the drawing title and section callout are updated immediately.
5. If necessary, flip the direction of the Section B-B callout.
   Although you changed the sheet model name to Sections, the sheet name is still set to Section A-A. This is reflected in the callout circles.
6. In the Models dialog, select the Sections sheet model, click Edit Model Properties, and set the following:
   - **Update Fields Automatically:** enabled
   - **Sheet Name:** Sections
The sheet names in the drawing titles are updated.

Probably the first callout in the drawing model has lost the values of its fields, also because the sheet model has been renamed.

7. To correct this select Element Information and select the callout.

8. Open the Links section of the Element Information dialog, click in the Links field, and click the browse button.

9. In the new dialog, click in the Model Name field, select Sections from the list of sheet models, and click OK.

10. Open the Annotate task and select Update All Fields, to update the text fields in the callout.

Exercise: Create a sheet model with the floor plan and an elevation

1. Continuing in House.dgn, open the Models dialog.

2. Create a new sheet model Plans and Elevations, based on the seed model SheetSeed in ..\General\dgnlib\general.dgnlib, with the annotation scale set to Full Size 1=1 and Update Fields Automatically enabled.

3. Select Previous Model to return to the multi-model views.


To attach the floor plan to the sheet you can use the saved view Plan [Drawing]. This saved view was created automatically when creating the drawing model.

5. Drag the saved view Plan [Drawing] from the Saved Views dialog to View 4, set the scale to 1:50, enable Synchronize with Saved Views and Create Drawing Title, and place it in the upper left corner on the sheet.

6. Move the drawing title closer to the plan.

You will add an elevation callout to the drawing model in View 2 and add the linked saved view to this sheet.
In the Annotate task, select Place Elevation Callout, and set the following:

*Detailing Style:* Default

*Annotation Scale lock:* enabled

*Preserve Up:* enabled

*Create Dynamic View:* enabled

Identify an element in the floor plan in View 2.

Place the elevation symbol above the floor plan and rotate it to let it point downwards.

In the Create Dynamic View dialog, only enable Create Saved View, set the name to Rear Elevation, and click OK.

An elevation callout is added to the drawing model.

Drag the new saved view Rear Elevation from the Saved Views dialog to View 4, set the scale to 1:50, enable Synchronize with Saved Views and Create Drawing Title, and place it on the sheet.

**Exercise: Add a detail to the sheet model**

1. Continuing in House.dgn, in View 2, zoom in to the upper right corner of the house.

2. In the Annotate task, select Place Detail Callout, and set the following:

   *Detailing Style:* Default

   *Draw Circle:* enabled

   *Annotation Scale lock:* enabled

   *Create Dynamic View:* enabled

3. Identify an element in the floor plan.

4. Draw a detail circle by defining the center and the edge, place a point to define the callout line, and reset to place the callout.

5. In the Create Dynamic View dialog, only enable Create Saved View, set the name to Detail A, and click OK.
A detail callout is added to the drawing model.

Note that the saved view Detail A is part of the drawing model Plan.

6 Drag the saved view Detail A from the Saved Views dialog to View 4, set the scale to 1:20, enable Synchronize with Saved Views and Create Drawing Title, set the drawing title to Detail A, and place it on the sheet.

Modifying dynamic views

There are several ways to modify a dynamic view that is linked to a callout:

- by selecting and modifying the callout;
- by modifying the callout through the Element Information dialog;
- by modifying the associated saved view.

Selecting and modifying the callout

When selecting a section or elevation callout, the associated clip volume displays which you can modify through its edit handles. When selecting a detail callout, the handles appear on the callout geometry itself.

Note: How to modify a clip volume is explained in the module ‘Viewing xxx’, in the chapter ‘Using Clip Volumes and Display Styles’.
Additionally, in a section callout, you can create steps and gaps by right-clicking the section callout and selecting Create Step or Create Gap. The steps you create are propagated to the corresponding section view’s clip volume.
A gap is created along the length of the section callout and does not affect the corresponding section view’s clip volume. It is useful for hiding certain portions of the section line to reduce clutter in the drawing.

To change the direction of a section callout right-click the callout and select Flip Direction.
To change the direction of an elevation callout you can rotate the elevation symbol itself.

**Note:** Always enable Create Dynamic Views when placing a callout. If you place a callout with Create Dynamic Views disabled, the saved view is not associated with it. You can manually associate the saved view with the callout by right-clicking the saved view in the Saved Views dialog, selecting Associate Callout, and then selecting the callout. In that case, the callout’s fields are updated when the saved view is attached to a sheet, but the saved view is not updated when you modify the callout.

### Modifying a callout through the Element Information dialog

When you select a callout with the Element Information tool, you can view and modify its properties in the Element Information dialog. You can for example change its detailing symbol style or update its link.

### Modifying the saved view

To be able to change the display properties in section and elevation views, you have to open the respective saved views. An easy way to do this is to open an extra view, right-click the callout in the drawing or sheet model, select Open Dynamic View in the context menu, and click in the extra view.
In that view, you can change for example the level display, view attributes, or display styles, and then update the settings of the saved view that you opened. The changes are immediately reflected in the sheets to which the saved view is attached, provided that Synchronize with Saved View is enabled.

**Exercise: Modify the callouts and the saved views**

1. Continuing in House.dgn, make View 2 with the drawing model active.
2 Make the boundary of the Detail A saved view visible by clicking in the Show column in the Saved Views dialog.

3 Ensure the Element Selection tool is active, select the detail callout in View 2, and move one of the handles to modify the radius of the detail circle.

Note that the saved view boundary is also modified and the associated saved view is updated.

You will create a step in the Section B-B callout.

4 Right-click the Section B-B callout and select Create Step.

5 Snap to the center of the section line and create a step.

A step handle is placed on every step. Also note the dynamic change to the section view in View 3.

You will merge the steps again.

6 Click the step handle of the step that is to be merged, for example step handle 3, and drag the handle to merge it into another step.

Let’s turn off the display of the dinner table in Section B-B. To be able to do this you have to open the Section B-B saved view in a separate view first.

7 Open View 5 and place it somewhere on your screen.

8 Activate View 2 and ensure that Element Selection is active.
9 Right-click the callout that defines Section B-B and select Open Dynamic View.

10 Select the target view by clicking in View 5.

   The saved view Section B-B is applied to View 5 (not attached as reference, just opened).

11 In View 5, right-click the table, select Level Off, and click in the view.

   Then you have to update the saved view settings of the Section B-B saved view.

12 In the Saved Views dialog, select the Section B-B saved view, select Update Saved View Settings, and click in View 5.

   The Section B-B saved view that is attached to the Sections model in View 3 is updated.

13 Close View 5.

Displaying and annotating section graphics

When creating a dynamic plan view, section view, elevation view, or detail view in a 3D environment, section graphics are generated on the fly. Section graphics are new geometry, drawn as the result of cutting the design model with a section clip element. Section graphics are not persistent elements.

The display of dynamic volumes and dynamic sections can be controlled using display styles. A display style consists of a render mode and optional settings and overrides.

Note: Read more about using display styles in the module ‘Viewing xxx’, in the chapter ‘Using Clip Volumes and Display Styles’.

In addition, section graphics can be patterned or hatched, and the dimensioning tools are capable of creating dimensions associated to section graphics.

Patterning section graphics

To use a pattern to represent section graphics, you have to create an element template that contains patterning properties, and associate (lock) that template to the solids in the design model that will be cut. Then the pattern will be applied to all section graphics produced from those solids. So the element template is not associated to the section graphics, but to the original solids.
Note the difference between using a display style and apply patterning. A display style is applied to all section graphics within a certain clip volume category (Cut, Forward, Back, Outside) or to a view, while patterning is associated to specific elements. This allows you to apply different element templates to solids, resulting in section graphics with different patterns.

Hint: Using an element template also allows you to determine on which level the section graphics are placed.

Annotating section graphics

Section graphics can be annotated using the normal annotation tools. For example, you can use the Dimension Element tool to create a linear dimension that is associated to a linear section graphic.

Hint: If the annotation is hidden below the reference model, change the update sequence of the references (References dialog, Settings > Update Sequence), so that the elements in the active model are displayed on top.

Exercise: Create and apply display styles

1  Continuing in House.dgn, select Display Styles... in the Settings menu.
2  In the Display Styles dialog, create a new display style Section, using the following settings:
   Display: Filled Hidden Line
   Element > Color: enabled + 3
   Visible Edges > Color: enabled + 0
   Visible Edges > Solid Line Style: enabled
   Visible Edges > Weight: enabled + 1
   Usages > View: disabled
   Usages > Clip Volume: enabled
3  Close the Display Styles dialog.
4  Make View 1 active and open the View Attributes dialog.
5  In the Clip Volume Settings section, behind Cut select the newly created display style Section.
   The dynamic sections in the 3D model change to red instead of blue.
   To synchronize the colors in the plan view in View 2, you have to update the Plan saved view settings.
Open the Saved Views dialog and select the Plan saved view in the list.

Select Update Saved View Settings, ensure that Update Camera Position is off, and click in View 1, the view to update from.

**Hint:** If View 1 was not active yet, you have to click twice in View 1.

The sections in the plan view and the detail view now change to red too.

But..., the sections in the Section A-A view and the Section B-B view remain blue. To update these, you have to change the clip volume settings that were used when creating these section views. To be able to change these clip volume settings, you have to open the respective saved views.

Open View 5 and place it somewhere on your screen.

Activate View 2 and ensure that Element Selection is active.

Right-click the callout that defines Section A-A and in the context menu select Open Dynamic View.

Select the target view by clicking in View 5.

The saved view Section A-A is applied to View 5.

In View 5, open the View Attributes dialog and in the Clip Volume Settings section, behind Cut select the display style Section.

Then you have to update the saved view settings of the Section A-A saved view.

In the Saved Views dialog, select the Section A-A saved view, select Update Saved View Settings, and click in View 5.

The Section A-A saved view that is attached to the Sections model in View 3 is updated.

To update the Section B-B saved view too, repeat the five previous steps.

Close View 5.
Exercise: Apply patterning to represent the walls and cabinets sections


2. In the Element Templates dialog, select House.dgn in the left pane and click New Template.

A new template group with a new template is created in House.dgn.

3. Rename the new template to Section_walls and the template group to Sections.

4. Right-click the template and select Add > Pattern/Hatch > Area Pattern Properties.

The Pattern/Hatch Settings are added to the Properties pane and apply the current default values that would be used by the hatch or pattern tools.

5. Set the following properties:
   - **Levels**: walls
   - **Colors**: 1
   - **Line Styles**: 0
   - **Weights**: 0

   **Area Pattern Cells**: ANSI32 (First open the Cell Library dialog and attach the cell library archpa.cel in ..\WorkSpace\System\cell\.)
   - **Area Pattern Scales**: 0.3
   - **Area Pattern Spacing**: 0,0
Using Dynamic Views in 3D

Area Pattern Angles: 135

6 Close the Element Templates dialog.
You will associate this template to all the solids that form the walls of the house.

7 Make View 1 active and in the Level Display dialog turn off all the levels except the Walls level.

8 Use the Level tab in the Element Selection tool settings dialog to select all elements on the level Walls.

9 Check if the Active Element Template icon in the Attributes toolbox is displayed with highlighting on a depressed background.

10 If not, click the icon to change its state to activated.

11 Click the arrow next to the Active Element Template icon and select the Section_walls template.
This will associate (lock) the selected elements to the template.

12 Clear the selection set.
The template is immediately applied to all section graphics that are produced from the wall solids, but the pattern is not visible, because the display style overrules it.

13 In View 1, set the display style of the Cut clip volume category to From View (View Attributes dialog, section Clip Volume Settings).

14 Additionally, set the display style of View 1 to Hidden Line (View Attributes dialog, section Presentation).

15 Turn the levels on again.
16 Update the settings of the Plan saved view.

![Image of Plan saved view]

17 Define another element template named Section_cabinets with the following properties:

- **Levels:** cabinets
- **Colors:** 4
- **Line Styles:** 0
- **Weights:** 0
- **Area Pattern Cells:** ANSI31
- **Area Pattern Scales:** 0.3
- **Area Pattern Spacing:** 0,0
- **Area Pattern Angles:** 45

18 Associate all elements on the Cabinets level to this new template.

You don’t have to update the saved view, as the symbology of the elements themselves are changed, not the display properties.

![Image of new template applied]

⇒ **Exercise: Place dimensions on section graphics**

1 Continuing in House.dgn, zoom to the upper right corner of the house in the drawing model in View 2.
2 Create a new level Dimensions and activate it.

3 In the Annotate task, select Dimension Element, set the dimension style to None and the alignment to True.

4 Select the outside of the right wall and place the dimension.

5 Select Dimension Linear and dimension the oblique corner.

The dimensions are also displayed on the Plan and Elevations sheet.

You will turn off the general dimensions in the detail view.

6 Open View 5 and open the Detail A view by right-clicking the Detail A callout, selecting Open Dynamic View, and clicking in View 5.

7 Turn off the level Dimensions and update the settings of saved view Detail A.

The dimensions are only visible in the Plan [Drawing] view now. If you like, you can add more detailed dimensions to the detail on the sheet or on a separate level in the drawing model.

More about drawing titles

Using one of the Detailing Symbols tools with Create Dynamic View and Create Saved View enabled, you can place a callout and create a saved view that is associated with the callout. Doing this ensures that:

- the saved view is updated when you modify the callout;
- the callout's fields are updated when the saved view is attached to a sheet.
When you attach the saved view to a sheet model, a drawing title can be created that describes the referenced model.

![Drawing title](image)

**Note:** When a saved view is attached to a design or drawing model, the option to create a drawing title is disabled. Drawing titles should not be placed in a drawing model, because their fields cannot be updated.

In addition to the creation of the reference and the drawing title, a link is established between the callout and the drawing title. Using this link the placeholder fields in the callout evaluate and display the corresponding property values of the drawing title. So the drawing title plays a crucial role in automatically linking callouts across sheets.

**Drawing title identifiers**

When you compose a sheet, a unique drawing title identifier is automatically created for each drawing title that you place on the sheet. The identifier is displayed as a field in the drawing title and in the corresponding callout.

A default section callout for example displays the drawing title identifier (2) and the sheet name of the sheet model (Sections). They enable you to easily navigate between drawing titles on different sheets.

![Section callout in a drawing model](image)

The placeholder fields in the default drawing title display the drawing title identifier (2), the sheet name of the sheet model (Sections), the drawing title name (Section B-B), and the detail scale (1:50).
Sheet names and sheet numbers

Assigning a sheet name and number to a sheet model is optional. They enable you to refer to sheets by name for convenience or by number for ordering purposes. You can set a sheet name and number when creating a sheet model and edit them in the Models dialog. A sheet name can be displayed in drawing titles and callouts using fields. If the sheet name is changed, the field value updates. This makes it easy to change sheet names when inserting new sheets or reordering sheets in a set.

As sheets are added during the course of a design project, it may be necessary to renumber sheets in a set. You can renumber sheets manually using the Edit Model Properties tool in the Models dialog, or automatically with the renumbering tool in Project Explorer.

Hint: Ensure that Update Fields Automatically is enabled for the models that contain the fields that should be updated.

Note: In 2D, you cannot use section and elevation callouts to automatically create section and elevation views, because they expect 3D models. So in 2D, you need to place the section or elevation callouts without creating the view and add section callout links to the drawing title using the Add Link to Element tool in the context menu.

Exercise: Update a callout field

1. Continuing in House.dgn, open the Models dialog.
2. Select the Plan drawing model and click Edit Model Properties.
3. Enable Update Fields Automatically and click OK.
4. In View 3, zoom in to the drawing title of Section B-B, right-click it, and select Element Information from the menu.
5. In the Element Information dialog on the General tab, change the Identifier value.
6. Click in View 2 to activate it and in the Annotate task select Update All Fields.

The drawing identifier field in the Section B-B callout updates.
Placing a callout from an existing dynamic view

Instead of placing a callout and automatically generating a linked dynamic view, it is also possible to generate a callout from an existing dynamic view. You can use this for example to refer to a specific section view on a sheet from multiple other sheets. The section callouts visually represent the section view on those other sheets.

Exercise: Place a section callout from an existing section view

1. Continuing in House.dgn, open the Models dialog.
2. Create a new sheet model Plan Extra based on the seed model SheetSeed in ..\General\dgnlib\general.dgnlib, with the annotation scale set to Full Size 1=1 and Update Fields Automatically enabled.
3. Select Previous Model to return to the multi-model views.
4. Open View 6 and in the View Attributes dialog set the model to Plan Extra.
5. Open the Saved Views dialog, drag the saved view Plan to View 6, and attach it with scale 1:50, Synchronize with Saved View enabled, and the drawing title set to Plan.
6. Turn off the grid lock and place the saved view Plan in the sheet model Plan Extra.

Now you will place an extra section callout that points to the existing Section A-A view.

7. In the Saved Views dialog, right-click the saved view Section A-A and select Generate Callout in the context menu.
8. Click on an element in View 6 to select the model in which to place the callout.

The callout is placed at the right location in the Plan Extra model, but the fields in the callout are not updated. That’s because there is no link yet
between the callout and the Section A-A saved view that is placed in the Sections sheet model.

9 Ensure Element Selection is active and hold the mouse still on the callout in View 6.

No link is displayed in the pop-up info.
You will create a link between the drawing title of Section A-A and the new callout.

10 In View 3, in the Sections model, right-click the drawing title below Section A-A and select Add Link to Element.

11 In View 6, select the callout.

Note that a link is displayed in the pop-up info now.

12 Select Update All Fields in the Annotate task to update the fields in the callout.

If you change one of the section callouts, the change is propagated to the section view and then to all other linked section callouts. So let’s modify the callout in View 6 and see what happens.

13 Select the callout in View 6 with Element Selection and move its clip plane by dragging the green arrow (or flip the direction and click in the view).

Watch how the section callout in View 2 and the Section A-A view in View 3 both are updated.
Module Review

Now that you have completed this module, let’s measure what you have learned.

Questions

1. Name the steps in the drawing composition workflow.
2. Define a design.
3. Define design composition.